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About This Guide

This guide explains how to set up, customize, and extend
wiki services.

Mac OS X Server includes wiki services, which allow you to set up personal and group
wikis, blogs, and web calendars.

The default wiki services configuration makes it easy for groups to collaborate and
communicate. Users can create and edit wiki pages, tag and cross-reference material,
upload files and images, add comments, and search content.

In addition to showing you how to set up wiki services, this guide shows you how to
customize and extend them to suit your needs. For example, you'll learn how to:

« Create custom themes
+ Enable JavaScript, YouTube, and Flash
+ Enable Quick Look for more file types

+ Automate migration from other sources, such as wikis and non-wiki websites

Customizing and extending wiki services requires administrator access and in some
cases programming skill. You must be able to edit files on the server, which aren’t
accessible to most users. Be careful when editing these files. An incorrect or untested
change could cause problems.

What's New in Wiki Server

+ Users create and administrate their own wikis and blogs. After enabling wiki
services, users can create wikis and blogs. They can choose which wiki services to
enable, such as just the wiki and calendar, and they can choose who can access their
wiki services. Users can do these tasks within the wiki tools, so server administrators
don’t need to be involved.

Server administrators can restrict who is allowed to create wikis and blogs.

For more information, see Wiki Help or Wiki Tools Deployment Guide.

Preface
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+ Quick Look support. Users can use Quick Look to preview attached files without
downloading the files. By default, users can use Quick Look to preview any file types
that can be previewed in Finder, such as Keynote, Pages, and PDF files. You can
enable Quick Look for more file types.

For more information, see Chapter 5,"Allowing Specific File Types for Quick Look.”

+ Improved iPhone support. Wiki tools look and work better than ever on iPhone.

For more information, see Wiki Help on iPhone.

What's in This Guide

This guide includes the following chapters:

« Chapter 1,"About Wikis, Blogs, Web Calendars, and Mailing Lists,” highlights
important collaboration concepts and introduces wiki tools.

+ Chapter 2,“Enabling and Configuring Wikis, Blogs, Web Calendars, and Mailing Lists,”
shows you how to use Server Admin to set up wiki services.

+ Chapter 3,“Customizing How the Wiki Looks,” describes how to create custom
themes and edit CSS, property list, JavaScript, and XSL files.

+ Chapter 4,"“Allowing Specific Protocols, CSS Styles, and HTML Tags and Attributes,”
describes how to allow users to use specific protocols, CSS styles, and HTML tags
and attributes.

+ Chapter 5,"Allowing Specific File Types for Quick Look,” shows you how to enable
Quick Look for additional file types.

+ Chapter 6,"Managing Wiki Content,” describes how to migrate, back up, and edit raw
wiki content.

Note: Because Apple periodically releases new versions and updates to its software,
images shown in this book may be different from what you see on your screen.

Using Onscreen Help

You can get user help while using the wiki tools on your computer or iPhone, or
administration task instructions in the Help Viewer application while you're managing
Snow Leopard Server. You can view administration help on a server or an administrator
computer. (An administrator computer is a Mac OS X computer with Mac OS X Server
administration software installed on it.)

To get user help while using wiki tools on your computer:
Click the "help” link.

To get user help while using wiki tools on iPhone:
Click the “help” link.

Preface About This Guide
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This link is located at the bottom of the page.

To get administration help:
Open Server Admin and then:

+ Use the Help menu to search for a task you want to perform.

+ Choose Help > Server Admin Help to browse and search help topics.

The onscreen help contains instructions taken from Advanced Server Administration
and other administration guides.

To see the most recent server help topics:

Make sure the server or administrator computer is connected to the Internet while
you're getting help.

Help Viewer retrieves and caches the most recent server help topics from the Internet.
When not connected to the Internet, Help Viewer displays cached help topics.

Documentation Map

Mac OS X Server has a suite of guides that cover management of individual services.
Each service may depend on other services for maximum utility. The documentation
map below shows some related guides you may need to fully configure Wiki Server to
your specifications. You can get these guides in PDF format from the Mac OS X Server
resources website:

Preface About This Guide
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www.apple.com/server/macosx/resources/

Getting Started

Explains how to
set up collaboration
services using
Server Preferences.

Introduction to
Command-Line
Administration

Explains how to use
UNIX shell commands to
configure and manage
servers and services.

Wiki Tools
Deployment Guide
Describes wiki tools
and concepts, and
explains how to
deploy wiki tools in
your environment.

Wiki Help
Provides onscreen
instructions and

answers when you're
using wiki tools.

iCal Server
Administration

Explains how to
set up and customize
iCal service, which
is used for web
calendars. iPhone Wiki Help

Provides onscreen
instructions and

Wiki Server answers when

Administration you're using

. iPhone wiki tools.
Explains how to

set up wiki services
using Server Admin, and
how to customize and
extend the services.

Viewing PDF Guides Onscreen
While reading the PDF version of a guide onscreen:

+ Show bookmarks to see the guide’s outline, and click a bookmark to jump to the
corresponding section.

+ Search for a word or phrase to see a list of places where it appears in the guide. Click
a listed place to see the page where it occurs.

« Click a cross-reference to jump to the referenced section. Click a web link to visit the
website in your browser.

Printing PDF Guides

If you want to print a guide, you can take these steps to save paper and ink:

« Save ink or toner by not printing the cover page.

Preface About This Guide
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« Save color ink on a color printer by looking in the panes of the Print dialog for an
option to print in grays or black and white.

+ Reduce the bulk of the printed document and save paper by printing more than
one page per sheet of paper. In the Print dialog, change Scale to 115% (155%
for Getting Started). Then choose Layout from the untitled pop-up menu. If your
printer supports two-sided (duplex) printing, select one of the Two-Sided options.
Otherwise, choose 2 from the Pages per Sheet pop-up menu, and optionally choose
Single Hairline from the Border menu. (If you're using Mac OS X v10.4 or earlier, the
Scale setting is in the Page Setup dialog and the Layout settings are in the Print
dialog.)

You may want to enlarge the printed pages even if you don't print double sided,
because the PDF page size is smaller than standard printer paper. In the Print dialog or
Page Setup dialog, try changing Scale to 115% (155% for Getting Started, which has CD-
size pages).

Getting Documentation Updates
Periodically, Apple posts revised help pages and new editions of guides. Some revised
help pages update the latest editions of the guides.

+ To view new onscreen help topics for a server application, make sure your server or
administrator computer is connected to the Internet and click “Latest help topics” or
“Staying current” in the main help page for the application.

« To download the latest guides in PDF format, go to the Mac OS X Server Resources
website at:

www.apple.com/server/resources/.
+ An RSS feed listing the latest updates to Mac OS X Server documentation and

onscreen help is available. To view the feed, use an RSS reader application such as
Safari or Mail and go to:

feed://helposx.apple.com/rss/snowleopard/serverdocupdates.xml

Getting Additional Information
For more information, consult these resources:

+ Read Me documents—get important updates and special information. Look for them
on the server discs.

« Mac OS X Server website (www.apple.com/server/macosx/)—enter the gateway to
extensive product and technology information.

+ Mac OS X Server Support website (www.apple.com/support/macosxserver/)—access
hundreds of articles from Apple’s support organization.

Preface About This Guide n
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« Apple Discussions website (discussions.apple.com/)—share questions, knowledge,
and advice with other administrators.

« Apple Mailing Lists website (www.lists.apple.com/)—subscribe to mailing lists so you
can communicate with other administrators using email.

« Apple Training and Certification website (www.apple.com/training/)—hone
your server administration skills with instructor-led or self-paced training, and
differentiate yourself with certification.

Preface About This Guide
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About Wikis, Blogs, Web Calendars,
and Mailing Lists

Learn about the tools provided by Wiki Server.

Wiki Server provides several web-based wiki tools that allows users to express
themselves or to easily form, coordinate, and organize teams.

About Wikis

A wiki is a web-based collaborative editing environment for groups. Depending on
how the wiki administrator sets permissions, anyone who can view wiki content can
also add or edit content.

Wikis have several advantages over other tools:

Advantage Description

Fast and easy To edit wiki pages, click the Edit (pencil) button
on a page you want to edit. Add content and use
a simple toolbar to apply styles, add links to other
sites, attach files, or insert media. You don't need
to learn additional tools.

Streamlined If you see a page you'd like to correct or add
content to, you can change it yourself. With other
tools, you must find the owner, describe the issue
to the owner, and then the owner would have to
change the content.

Customizable It's easy to change how users navigate to
information, whether through a broad or deep
navigational hierarchy, or through tags.

Dynamic Because wiki content can be updated by a large
group of people, it is much more dynamic than a
static medium like PDF.

Parallel content creation Multiple people can edit wiki content on different
pages simultaneously.

Cross-reference information It's easy to link together information within and
outside of the wiki.

13
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About Blogs
A blog is like an online journal. Entries are arraned chronologically with the newest
entries listed first.

The blog and the wiki share the same simple editing toolbar and thus share a lot of
the same advantages. The biggest difference between a blog and a wiki is that the
blog has a sense of time but the wiki doesn’t. In a blog, new content is found more
easily than older content. In a wiki, content is found by need or by navigation, rather
than by time.

Blogs are available for users and groups. Users can edit the group blogs they have
access to.

About Web Calendars

Users and groups can have web calendars:

+ User web calendars let you schedule private events, or send event invitations to
other users. Other users can't see your web calendar.

+ A group web calendar is like a hallway calendar—its a very visible calendar that
everyone in a group can edit. It's very good for highlighting important dates.
However, you can't send invitations through group calendars.

Because the web calendar uses iCal server, all users who have set up their server
account in iCal will have synced calendars. Event changes made in the web calendar
are reflected in iCal, and event changes in iCal are reflected in the web calendar. If
you sync group web calendars, the local iCal version of the calendars are read-only.
Changes you make to the group web calendars are synced with iCal but you can't edit
the calendars in iCal.

The web calendar is designed to simplify creating events and sending invitations. Web
calendars don't allow dependencies, so its not good for project management where
milestones often depend on each other. It also doesn't allow delegates, so you should
use iCal if you want to use delegates.

About Mailing Lists

Every wiki can have a logged mailing list. Email sent to the wiki’s email address is
archived in the mailing list. Unlike the wiki and blog, content in logged mailing lists
can't be changed or commented on. However, logged emails can be tagged, and
because they each have a URL, you can link to them.

The group email address is wikiname-wiki@serverurl.

For example, if your wiki’s name is Aardvark and the URL of your wiki server is
www.example.com, the wiki email address is aardvark-wiki@example.com.

Chapter 1 About Wikis, Blogs, Web Calendars, and Mailing Lists
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Enabling and Configuring Wikis,
Blogs, Web Calendars, and Mailing
Lists

Learn how to use Server Admin to enable and configure
websites with wiki tools.

You use Server Admin to enable and configure websites with wiki tools. Websites with
wiki tools have My Page, which is a portal page that allows users to create wikis, blogs,
web calendars, and mailing lists.

Setting Up Wiki Server

Here is an overview of the basic steps for setting up wiki server.

Step 1:Set up and start iCal service. To host web calendars, you must set up and start
iCal service.

Step 2: Configure web service. Web service configuration applies to all websites,
which includes all wikis. You can change the data store location, maximum attachment
size, and default wiki theme.

Step 3:Set up a website. Set up a website so it enables wikis and blogs, and possibly
a web calendar and a mailing list. You can also restrict wiki creation to a few users.

If you set up multiple websites, you can set different settings and permissions per
website.

Step 4: Start web service. After setting up web service and a website, start the service.

Step 5: Create a wiki and test web service and wiki configurations. Wikis can be
created by anyone you allow. Users have access to My Page, which allows them to
create wikis and blogs. Users do not need server access or server tools.

Setting Up and Starting iCal Service on the Wiki Server

You can enable web calendars if you run iCal service on the same server that is hosting
wiki server. You can use the default iCal service settings. If you want to enable iCal
service on a different server, see “Setting Up iCal Service on a Different Server than the
Wiki Server” on page 14.

The default settings are:
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Setting Default

Data Store /Library/CalendarServer/Documents/
Maximum Attachment Size 1 MB

User Quota 100 MB

Authentication Any Method

Host Name The host name of the Wiki server
Secure Sockets Layer (SSL) Don't Use

HTTP Port Number 8008

Log Level Warning

Push Notification Server None

For information about changing these settings, see iCal Service Administration.
To start iCal service:

Open Server Admin and connect to the server.

Click the triangle at the left of the server.

The list of services appears.

If iCal is not listed, select the server and click Settings; then click Services, select iCal,
and then click Save.

From the expanded Servers list, select iCal.
The status icon at the left of iCal turns green if web service is running.

If iCal is not running, click Start iCal.

Setting Up iCal Service on a Different Server than the Wiki Server
You can host iCal service on a different server than the one running wiki service and
automatically redirect users to the iCal server when they access web calendars.

To use a different server for iCal service:

Open Server Admin and connect to the web server.
Click the triangle at the left of the web server.

The list of services appears.

If Web is not listed, select the server and click Settings, then click Services, select Web,
and then click Save.

From the expanded Servers list, select Web.

5 Click Settings, then click Wiki.

Click Configure next to External Web Services.

Chapter 2 Enabling and Configuring Wikis, Blogs, Web Calendars, and Mailing Lists
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In the Calendar Server field, enter the address of the iCal server.
If SSL is enabled, select SSL.
Click Done.

To use a different server for iCal service from the command line:
On the server running wiki services, in Terminal, open
/etc/apache2/httpd_webcalendar.conf in a text editor.

To open this file in a command-line text editor, enter:
$ sudo nano /etc/apache2/httpd webcalendar.conf

If prompted, enter your administrator account password.

You can use any command-line text editor as long as you precede the command to
run the text editor with sudo.

Change all calendar-oriented proxy lines from 127.0.0.1 to your calendar server’s host
name.

On the server hosting iCal service, in Terminal, open /etc/caldavd/caldavd.plist in a text
editor.

To open this file in a command-line text editor, enter:

$ sudo nano /etc/caldavd/caldavd.plist
If prompted, enter your administrator account password.

You can use any command-line text editor, as long as you precede the command to
run the text editor with sudo.

You can also use Property List Editor to edit this file. For more information, see “About
Property List Editor” on page 33.

Under the Authentication:Wiki section, add the following lines:
<key>URL</key>
<string>http://wiki.server.address/RPC2</string>

Configuring Wiki Settings for All Websites
Wiki settings apply to all websites and thus all wikis hosted on a server. The default
settings should work for most users.

Wiki settings include:

Chapter 2 Enabling and Configuring Wikis, Blogs, Web Calendars, and Mailing Lists 17
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Setting Default Description

Data Store /Library/Collaboration/ Wiki, blog, web calendar, and
mailing list pages are stored in
this location.

To change this location,

copy the contents of
/Library/Collaboration/ to the
new location with permissions
intact. To do this, enter this in
Terminal:

sudo ditto /Library/
Collaboration/
newlocation

Maximum Attachment Size 50 MB This is the maximum
attachment size for any single
file (including media such as
images, podcasts, and videos)
uploaded to the wiki or blog, or
attached to email.

Users can upload several files
below this maximum and have
more than this size on a page.

Default Theme Apple Theme This is the default theme for
wikis. Wiki adminstrators (the
person who created the wiki,
or a server administrator) can
change the theme in the wiki.

Wiki Creators Empty (anyone can create wikis) This lists who can create wikis.
You can include users or groups
in this list. If you leave this list
empty, anyone with access to
the wiki server can create wikis.

SMTP Relay None If you're not hosting mail service
on the same server as the wiki
server, click Configure and enter
configuration information for a
SMTP server.

This is used to forward mail sent
to group mailing lists, and for
mail notifications.

External Web Services None If you're not hosting iCal or mail
service on the same server as
the wiki server, click Configure
and enter configuration
information for iCal or Mail
servers.

18 Chapter 2 Enabling and Configuring Wikis, Blogs, Web Calendars, and Mailing Lists
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To view web service settings for wikis:
Open Server Admin and connect to the server.

Click the triangle at the left of the server.
The list of services appears.

If Web is not listed, select the server and click Settings; then click Services, select Web,
and then click Save.

From the expanded Servers list, select Web.

Click Settings, then click Wiki.

Configuring Other Servers for Web Calendars and Mail Rules

You can host wiki service on a server and enable iCal service and mail service on
other servers. iCal service is required for web calendars and mail service is required for
setting up mail rules.

When you configure another server for mail rules, a user can configure mail rules in
his or her account settings page of a website hosted on the web server, even though
another server runs mail service.

You can enable Secure Sockets Layer (SSL) to increase security. SSL is optional for a
calendar server, but it is required for a mail server.

To configure external servers for web calendar and mail rules:
Open Server Admin and connect to the web server.

Click the triangle at the left of the server.

The list of services appears.

If Web is not listed, select the server and click Settings; then click Services, select Web,
and then click Save.

From the expanded Servers list, select Web.
Click Settings, then click Wiki.

Click Configure next to External Web Services.
Enter the host name of calendar or mail servers.

If you're using the web server you're configuring for calendar or mail service, you don't
need to enter host names in these fields.

If you're configuring a calendar server that uses SSL, select SSL.
Because SSL is required for server-side mail rules, SSL is already selected.

Click Done.

Chapter 2 Enabling and Configuring Wikis, Blogs, Web Calendars, and Mailing Lists 19
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After configuring other servers for web calendars and mail rules, enable them for
specific websites. For more information, see “Setting Up a Website for Wikis” on
page 20.

Configuring Other Servers for Hosting Wikis

You can host wikis on other servers, which can be accessed through a single host
name. So for example, if you have 2000 wikis, you can use four servers to host 500
wikis each. Users can access these wikis through the same host name (such as wikis.
example.com).

You need the following:

+ Main web server—This server runs web service but doesn’t need to run wiki service.
Users connect to wikis by using the host name of a website on this server.

« At least one other server—These servers run web service and wiki service.

The main web server should be able to connect to ports 8086 and 8087 on the other
servers.

The following tasks include an example scenario where Biology and

Algebra wikis are hosted on other servers (science.example.com and
math.example.com). After performing these steps, users can access the Biology
wiki from wikis.example.com/groups/biology/ and the Algebra wiki from
wikis.example.com/groups/algebra/.

To configure external servers for hosting wikis:
Copy wikis from the main web server to another server.

Wikis are stored in /Library/Collaboration/Groups/. For more information about the
wiki file structure, see “Wiki File Structure Overview” on page 68.

Edit the /etc/apache2/httpd_groups.conf file on the main web server:
a To edit this file in Terminal, enter:
sudo nano /etc/apache2/httpd groups.conf

If prompted, enter your administrator account password.

You can use any command-line text editor, as long as you precede the command to
run the text editor with sudo.

b For every wiki you host on other servers, add these lines:
<Location /groups/group name>
ProxyPassReverse http://external fqdn:8087/groups/group name

ProxyPass http://external fqdn:8087/groups/group name retry=5

</Location>

Chapter 2 Enabling and Configuring Wikis, Blogs, Web Calendars, and Mailing Lists



Apple Confidential Beta Draft

Replace group_name with the name of the wiki you're hosting. This is the same

as the name of the folder with all wiki files. Replace external_fqdn with the fully
qualified domain name of the external server. Add these lines when you move a wiki
to an external server.

In the example scenario, you'd enter the following lines:

<Location /groups/biology>
ProxyPassReverse http://science.example.com:8087/groups/biology
ProxyPass http://science.example.com:8087/groups/biology retry=5
</Location>
<Location /groups/algebra>
ProxyPassReverse http://math.example.com:8087/groups/algebra
ProxyPass http://math.example.com:8087/groups/algebra retry=5

</Location>
3 Edit the /etc/apache2/httpd_teams_required.conf file on the main web server:

a To edit this file in Terminal, enter:
sudo nano /etc/apache2/httpd teams required.conf

b For every other server, add these lines:
<Location /RPC2/server name>

ProxyPass /RPC2 http://external fqdn:8086/RPC2 retry=5

</Location>
Replace server_name with a name for the server. This is used in the next task and
doesn't need to be a formal name.

In the example scenario, you'd enter the following lines:
<Location /RPC2/science>
ProxyPass /RPC2 http://science.example.com:8086/RPC2 retry=5
</Location>
<Location /RPC2/math>
ProxyPass /RPC2 http://math.example.com:8086/RPC2 retry=5
</Location>
4 Edit the /etc/wikid/wikid.conf file on every external web server:
a To edit this file in Terminal, enter:
sudo nano /etc/wikid/wikid.conf
b Add these lines:

<key>serverRPCRedirect</key>

<string>/RPC2/server name</string>

Replace server_name with the name of the other server you entered in the previous
task.

In the example scenario, you'd enter the following lines in the the
/etc/wikid/wikid.conf in the server hosting science.example.com:

Chapter 2 Enabling and Configuring Wikis, Blogs, Web Calendars, and Mailing Lists 21
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<key>serverRPCRedirect</key>

<string>/RPC2/science</string>

In the example scenario, you'd enter the following lines in the the
/etc/wikid/wikid.conf in the server hosting math.example.com:

<key>serverRPCRedirect</key>
<string>/RPC2/math</string>

Setting Up a Website for Wikis
Web service can host several websites. Each website can have its own access
permissions and web services and can host multiples wikis.

When setting up a website, you can enable SSL to increase security, enable server-side
mail rules, and enable online password changing. If you enable SSL, you must create a
duplicate non-SSL site that redirects requests for podcasts or RSS feeds to the SSL site.

Additionally, the URL of the server homepage changes from http://homepage.example.
com/ to https://homepage.example.com/.

If server-side mail rules or online password changing are enabled, the user can access
these from the server homepage or from their account settings.

To set up a website for wiki services:

Open Server Admin and connect to the server.
Click the triangle at the left of the server.

The list of services appears.

If Web is not listed, select the server and click Settings; then click Services, select Web,
and then click Save.

From the expanded Servers list, select Web.

5 Click Sites, then select a site in the list.

10
n
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To enable SSL, click Security, select Enable Secure Sockets Layers (SSL), and choose a
certificate.

For more information about enabling SSL, see Web Technologies Administration.
Click Web Services.

To enable group wikis, select “Wikis.”

To enable user blogs, click “Blogs.”

To enable group and user web calendars, select “Calendars.”

To enable webmail, select “Mail.”

For more information about Webmail, see Mail Service Administration.

To enable configuration of server-side mail rules on the website, select “Allow users to
configure server-side mail rules.”
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If you enable server-side mail rules, users can also set up vacation notices to notify
anyone who sends mail to them that the user is not available to respond.

To allow users to change their password on the website, select “Allow users to change
their password.”

To allow users to access the wiki through shortened DNS names, click Aliases and add
website DNS aliases.

If you have a site named www.example.com, you could add an alias of example.com.
Users could then access your site from both URLs.

For more information about aliases, see Web Technologies Administration.

After saving website settings and restarting the web service, you can click the right-
arrow buttons next to the settings to visit the blogs, wikis, calendars or webmail pages
hosted on the website.

Starting Up Web Service
When you change web service settings, restart web service for the settings to take
effect.

Restarting the server and restarting web service can disrupt users, so send out a
notification that the server will be temporarily down before doing this.

To restart web service in Server Admin:
In Server Admin, click the triangle at the left of the server name hosting the web
service and select Web.

The status icon to the left of Web turns green if web service is running.
If web service is running, shown by a green status icon at the left of “Web,” click Stop
Web, then click Start Web; otherwise, click Start Web.

To restart web service in Server Preferences:
In Server Preferences, click Web, move the slider to Off, and then to On.

To restart web service at the command line:
Enter the following in Terminal:
$ sudo serveradmin stop teams; sudo serveradmin start teams;

If prompted, enter your administrator account password.

Connecting to Wikis
If wiki server is set up, connect to it by entering the URL of your wiki server in your
web browser.

At the server’s base level, you'll reach the default page:

Chapter 2 Enabling and Configuring Wikis, Blogs, Web Calendars, and Mailing Lists
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Name URL
Default home page /

Description

This is the default page that
appears when you enter your
sites base URL and you don't
set up an automatic redirect.
You can change this page in

The default page links to My Page—a set of portal pages that links accessible updated
pages, wikis, blogs, personal calendar, and settings. There are several My Page pages:

Name URL
Updates page /mypage/

Description

This page lists content updates
and comments on all pages the
user can access, showing the
most recently updated pages
first.

Wikis home page /groups/

This page lists all of the wikis
available on your web server.
This page also allows the user to
create and configure new wikis.

Blogs home page /users/

This page lists all of the user
blogs available on your web
server. This page also allows the
user to enable their own blog.

Calendar page /ical/

This page is a personal calendar
for the user. The user can send
and receive invitations on this
calendar.

Settings page /settings/

This page includes all personal
settings, such as account
preferences, password, and mail
rules.

Every wiki links to several pages:

24 Chapter 2 Enabling and Configuring Wikis, Blogs, Web Calendars, and Mailing Lists



Apple Confidential Beta Draft

Name URL Description

Wiki pages /groups/wikiname/wiki/uid/ Any member of a wiki can
pagename.html create or edit wiki pages.

Blog pages /groups/wikiname/blog/uid/ Any member of a wiki can
pagename.html create or edit blog pages.

Web calendar page /groups/wikiname/calendar/ Any member of a wiki can

create calendar events. Calendar
events are stored in the web
calendar page.

Mailing list entries /groups/wikiname/mailinglist/ ~ When someone sends an
uid/pagename.html email to wikiname-wiki@server.
example.com, a copy of the
email is created as an entry in
the mailing list.

Every user blog links to the following pages:

Name URL Description

Blog home page /users/username/ This page lists blog entries in
reverse chronological order.

Blog pages /users/username/weblog/uid/ Only the user or a wiki server
pagename.html administrator can add or edit
blog page entries.

Configuring Individual Wikis
A wiki administrator can change wiki settings. Wiki settings are grouped into several
categories:

Category Settings

General + Change the wiki icon (displayed at the top left)
+ Rename the wiki
« Describe the wiki
- Set a contact email
- Change the wiki theme

Services « Change which services are available
- Enable blog podcasts

Permissions « Choose who has access to the wiki and what level of access
they have
« Choose who can comment and which comments are
moderated
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Category Settings

Sidebar - Add a sidebar to the home page

Advanced « Choose which server addresses the wiki appears under

Advanced wiki settings are only available for server administrators.

For more information, see Wiki Tools Deployment Guide.

About Wiki Security
The level of website security determines the level of wiki security. Wiki security is
established when the website that the wiki is configured on is secure.

Methods you can use to help secure data moving to and from your wiki include the
following:

Set up SSL for the website your wiki is running on. SSL provides security for a site
and its users by authenticating the server, encrypting information, and maintaining
message integrity.

Specify users and groups who can create wiki pages on your website by adding
users and groups to the Wiki Admins list. For more information, see “Configuring
Wiki Settings for All Websites” on page 15.
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Customizing How the Wiki Looks

Learn how to customize a wiki’s appearance.

You can use a wiki’s admin settings to do the following:

+ Change the wiki’s title, description, contact email, and icon

+ Change the wiki's theme

+ Choose which group services are available

+ Create a podcast and integrate it with iTunes

+ Choose who can read, write, or administer the wiki

+ Choose who can make comments and which comments are moderated

+ Add a custom tag-search sidebar to the main page

These settings are sufficient for most wikis. However, if you have special needs—for
example, if you want to use a specific organization’s style, or if you want to change the

appearance and names of the default sidebars on the front page—you must edit files
located on the server.

The settings you customize affect wikis when you view them in a desktop Internet
browser or on a mobile device, such as iPhone.

Theme File Structure Overview

A theme is composed of Cascading Style Sheet (.css) files, property list (.plist) files,
image files (usually .png and .jpg), and sometimes JavaScript (.js) and Extensible
Stylesheet Language (xsl) files.

All themes use the CSS files located at:
/usr/share/collaboration/css/required/

However, CSS files located in individual theme folders take precedence and override
the settings in this folder.

Individual theme folders are subfolders with a .wikitheme extension that are located
within this folder:
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/Library/Application Support/Apple/WikiServer/Themes/

If the theme has a /compressed subfolder, it imports the CSS files located at:
/usr/share/collaboration/themes/theme_name/screen_compressed.css

The following shows how the /compressed folder imports screen_compressed.css.

/Library/Application Support/Apple/WikiServer/Themes/

L theme_name/

.
[l

E compressed/

|
screen.css

/usr/share/collaboration/themes/

| ———
Imports
theme_name/

| -
-—
-—

|
L screen_compressed.css

The screen_compressed.css file combines the many individual CSS files in the theme_
name/screen/ folder. These are provided in prebuilt themes to improve performance.
The screen_compressed.css file isn't created automatically or dynamically, so changes
to .css files in the theme_name/screen/ folder don't affect the screen_compressed.css
file.

Variant Theme File Structure Overview

Prebuilt themes have several variants, which share the same layout but might have
different banners or color schemes. Shared CSS files are in the main theme’s folder,
while variants have separate CSS files located in other folders.
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The following shows how theme variants import the main theme’s CSS and CSS files
located in the main theme and theme variant’s /screen folder.

/usr/share/collaboration/themes/

— || theme_name.variant/
p—l

— screen.css

L | screen/ Imports

‘ CSS file Imports

L theme_name/
—

— screen.css @

L | screen/
Imports

L CSS files 4—J

For example, the block theme has its shared CSS files located in:
/usr/share/collaboration/themes/block/screen/

Variants of the block theme use these shared CSS files. Each variant also uses CSS files
located in other folders such the following:

/usr/share/collaboration/themes/block.green.banner/screen/
/usr/share/collaboration/themes/block.red/screen/
/usr/share/collaboration/themes/block.red.banner/screen/

These CSS files serve as examples, because prebuilt themes use the
screen_compressed.css file instead of these files.
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Wireframe Theme File Structure Overview

The wireframe theme is a good example theme to customize, because unlike other
built-in themes, its CSS files are located in its main theme folder (in the /Library
location and not in the /usr location).

_“ /Library/Application Support/Apple/WikiServer/Themes/wireframe.wikitheme/
— preview.png

— print.css

— screen.css

\
— theme.plist

L screen/
-

— CSS files

S— img/

— banner.jpg

— comment.png

- rss.png

It is a bare-bones theme, which you can easily add to without removing unwanted
elements.

The wireframe theme’s folder includes the following files and folders:

File or Folder Name Purpose

preview.png Displayed when users are choosing which theme
to use. Its dimensions are 128 x 128 pixels.

print.css Applied when wiki pages are printed. If you don't
remove the import line from this file, printing
uses the print.css file located at:

/usr/share/collaboration/default/print.css

screen.css Applied when wiki pages appear on screen. This
file simplifies organization and file structure
by using the CSS files in /screen instead of
containing all CSS code in one file.

Chapter 3 Customizing How the Wiki Looks



Apple Confidential Beta Draft

File or Folder Name

Purpose

theme.plist Affects general settings (such as the theme’s
name), and sidebar attributes (such as the
maximum number of entries and types of
sidebars shown).

screen/ Includes all CSS files used when displaying the

wiki on screen.

screen/calendar.css

Sets the colors for the web calendar.

screen/comments.css Sets appearance attributes (such as padding,
borders, and positioning) for comment entry and
display.

screen/footer.css Sets footer attributes, such as the margin,
padding, color, and font size.

screen/forms.css Sets the margin for the search field.

screen/general.css

Sets general blog and wiki display attributes, such
as the font size and color, background colors,
heading margins, and list styles.

screen/grouphome.css

Sets display attributes for the sidebar located on
the main wiki page, such as size, margins, and
font size.

screen/header.css

Sets display attributes (such as the font size,
margin, and padding) for the wiki, blog, calendar,
and mail links located at the top of each page.

screen/layout.css

Sets display attributes (such as the margin and
size) for the wiki and blog editing interface.

Customizing the editing interface is an advanced
task; depending on what you're trying to do, you
may need to write JavaScript.

screen/metadata.css

Sets display attributes for fields in page histories,
such as the margin and font size.

screen/tables.css

Sets display attributes for tables and table
headers, such as the color, border styles, and font
size.

screen/tags.css

Sets display attributes for the tag list shown on
each page, such as the margins, padding, and
separators.

screen/thumbnail.css

Sets display attributes for image thumbnails,
such as border styles, color, padding, and the
magnification graphic.

screen/toc.css

Disabled. Don't edit.

Chapter 3 Customizing How the Wiki Looks
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File or Folder Name Purpose

screen/toolbar.css Sets the editing toolbar’s color, background color,
and margin.
screen/weblog.css Sets blog display attributes, such as which

elements are displayed.

screen/img/ Contains graphics used in the theme.

screen/img/banner.,jpg Default banner for the theme. Its dimensions are
950 x 140 pixels.

screen/img/comment.png Displayed in the upper right of every comment.
Its dimensions are 16 x 15 pixels.

screen/img/rss.png Displayed in the upper right of the What's Hot
and Recent Changes sidebars on the main page.
Its dimensions are 12 x 12 pixels.

Creating a Theme
The easiest way to create a theme is to take the existing wireframe theme, make a
copy of it with permissions intact, and then customize the copy.

If you edit the included themes instead of copying them to new themes, your edits
may be overwritten later by a software update.

To create a copy of the wireframe theme with permissions intact:
In Terminal, enter the following commands:

$ cd /Library/Application\ Support/Apple/WikiServer/Themes/

$ sudo ditto wireframe.wikitheme/ theme name.wikitheme/

Replace theme_name with the name of the theme you're creating.
If prompted, enter your administrator account password.

If you're going to use Property List Editor or a non—-command-line tool, copy the
theme.plist file to your Documents folder.

To copy this file, enter:

$ cp theme name.wikitheme/theme.plist /Users/user name/Documents/

Replace user_name with the short name of the user you're logged in as.

For information about Property List Editor, see “About Property List Editor” on page 33.
Open theme.plist in Property List Editor or a text editor.

To open this file in a command-line text editor, enter:

$ sudo nano theme name.wikitheme/theme.plist

If prompted, enter your administrator account password.
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You can use any command-line text editor, as long as you precede the command to
run the text editor with sudo.

If you're using Property List Editor or a non-command-line tool, open the theme.plist
located in your Documents folder.

Remove the selectable key and its value and then save the plist.

To remove the key using Property List Editor, select the selectable key and then click
Delete.

To remove the key using a text editor, remove the following lines:

<!-- remove this selectable key from your theme -->
<key>selectable</key>

<false/>

If you copied theme.plist to your Documents folder, copy it back to the theme folder.
To copy this file, enter:

$ cp /Users/user name/Documents/theme.plist theme name.wikitheme/
Restart web service.

For more information, see “Starting Up Web Service” on page 21.

Editing CSS Files

Cascading Style Sheet (.css) files control how a wiki looks. By editing CSS files, you can
change display attributes for specific page elements. For example, you can change:

+ Color

+ Background color
« Margin

« Padding

- Fontsize

If you're skilled at editing CSS files, you can completely overhaul the look of the wiki by
changing its layout, removing unwanted visual elements, and adding visual elements.

When you edit a CSS file, your changes occur immediately; you don't restart the server
or web service after editing. Because you might disrupt users by changing CSS files,
create, edit, and test them with a theme that isn't in use.

There are many online sources of information about Cascading Style Sheets. These
websites should help you get started:
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Website URL

World Wide Web Consortium w3.0rg

CSS3 css3.info

QuirksMode quirksmode.org
Position is Everything positioniseverything.net
The WebKit OpenSource Project webkit.org

A List Apart alistapart.com

CSS Zen Garden csszengarden.com

Here are some published CSS guides:
« (SS:The Definitive Guide, 3rd Edition, by Eric Meyer. O'Reilly Media, Inc. 2006.

« (SS Mastery: Advanced Web Standards Solutions, by Andy Budd, Simon Collison, and
Cameron Moll. Friends of ED. 2006.

Editing Property List Files

Every theme has a theme.plist file, which controls:

+ The name of the theme

+ Whether the theme is publicly available

+ The height and width of the banner

+ Sidebar properties, such as the name, type, and number of links, and sort order
After making changes to the theme.plist file, restart the web service or the server.

Because this can disrupt users, create, edit, and test themes on a test computer and
then copy them over to the server.
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About Property List Editor
Property List Editor (shown below) is a specialized editor for property list files.

@00 L theme.plist
(" NewSibling ) ( Delete )
Property List | Class | Value
¥ Root Dictionary 5 6 key/value pairs
bannerimageHeight Number 5 99.000000
bannerimageWidth Number = 950.000000
displayName String 3 Wireframe Theme
name String 3 com.applewireframe
w sidebars. Array 3 3
vo Dictionary &
displayName String
howMany String
b soriDirection Array
»tag Array
type String
uid String v
B Dictionary 5
»2 Dictionary 5 *
version String 1
A

To edit a theme.plist file using Property List Editor, copy it to your
Documents folder. When you finish editing theme.plist, copy it back to
/Library/Application Support/Apple/WikiServer/Themes/theme_name.wikitheme/.

Property List Editor is located on the Mac OS X Server v10.5 Administration Tools CD, in
/Utilities/. You can run it from the CD or copy it to another location.

Property List Editor doesn’t show comments, so to see the example sidebars provided
in the wireframe’s theme.plist file, open the theme.plist file in a text editor and remove
the comment markers surrounding the example sidebars.

About Property List Files

The theme.plist file is structured like an XML file. If you understand XML, editing
theme.plist is straightforward. If not, read the following sections for basic editing
information.

About Property List Keys and Values

Every setting controlled by theme.plist has a key and an associated value or an array (a
collection) of associated values. To change the setting, you change the value or values,
not the key.

For example, to halve the height of the banner image in Property List Editor,
double-click the value 99 next to bannerlmageHeight and replace it with 50.

To halve the height of the banner image in a text editor, change the following lines in
theme.plist:

<key>bannerImageHeight</key>

<real>99</real>
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to:

<key>bannerImageHeight</key>

<real>50</real>

About Strings
Most of the values in theme.plist are character sequences called strings.

About Dictionaries
A dictionary, or dict when viewed in a text editor, is an assortment of values of different
classes. In theme.plist, a sidebar is represented by a dictionary.

Because a dictionary can contain several values, Property List Editor provides a
disclosure triangle that allows you to view or hide the contents of the dictionary.

About Arrays
Arrays are collections or lists of similar classes. The theme.plist file includes two types
of arrays: a list of dictionaries and a list of strings.

The sidebars array is an example of a dictionary array. Because the sidebars array
is commented out by default, you can't see it in Property List Editor without first
removing the comment markers in a text editor.

Because an array can contain several values, Property List Editor provides a disclosure
triangle that allows you to view or hide the contents of the array.

Here is the sidebars array in a plain text editor:
<key>sidebars</key>
<array>
<dict>
sidebar keys and values
</dict>
<dict>
sidebar keys and values
</dict>

</array>

Here is an example of an array with a single string:

<array>
<string>value</string>

</array>

Here is an example of an array with multiple strings:

<array>
<string>value</string>
<string>value 2</string>

</array>
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About Comments

The theme.plist file includes comments to help provide editing instructions and
example keys and values. Comments are ignored when theme.plist is read by the wiki
server.

Comments start with “<!--"and end with “-->.” Everything in between is ignored, even if
the comment contains many lines of keys and values.

For example, the wireframe theme’s theme.plist file includes the following comment to
indicate where the example sidebars section starts:

<!-- example (non-default) sidebars -->

The sidebars array is preceded by a <!-- comment marker. The end comment marker
doesn’t appear until after the array. Because the comment markers surround the array,
the code for these sidebars in the array is ignored unless the comment markers are
removed.

About Errors

Make sure all required values are present. If you don't include required keys and values
in theme.plist (for example, a displayName or a uid for a sidebar), loading the wiki’s
main page will display an “Internal Server Error” page. Wiki pages that don’t have
sidebars won't display this error.

Changing General Theme Settings
The wireframe theme’s theme.plist file includes keys and values for the following
general settings:
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Default Value
99

Possible Values

Any number, 0 or more

Optional or Required
Optional

Description

The amount in pixels
alloted to the height
of the banner image.
Images you upload are
scaled to this size.

If you define
bannerlmageHeight but
not bannerimageWidth,
the width scales
proportionally.

This value affects the
banner image’s height,
not the banner’s
height. To change the
banner’s height, edit
the wireframe theme’s
layout.css file.

bannerlmageWidth

950

Any number, 0 or more

Optional

The amount in pixels
allotted to the width
of the banner image.
Images you upload are
scaled to this size.

If you define
bannerlmageWidth
but not
bannerimageHeight,
the height scales
proportionally.

This value affects the
banner image’s width,
not the banner’s
width. To change the
banner’s width, edit
the wireframe theme's
layout.css file.

displayName

Wireframe Theme

Any string (such as a
word or phrase)

Required

The name of the theme
as shown in the theme
chooser accessed from
a wiki's admin settings.
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Default Value Possible Values Optional or Required  Description
#848c64 # followed by a Optional The background color
hexadecimal color code shown behind the

name of the wiki and
navigation bar when
you view the wiki on
iPhone.

name

com.apple.wireframe Any string with no Required Uniquely identifies the
spaces theme.

selectable

<false/> <false/> Optional Displays a theme in
the theme chooser,
if the selectable key
and <false/> value are
removed.

version

2 A number Required Don't change this value.

Creating Sidebars
If you haven't created a sidebar before, it might be easier to customize an example
sidebar to suit your needs.

In the wireframe theme’s theme.plist file, a sidebars section contains an array of
sidebars you can customize:
<key>sidebars</key>
<array>
<dict>
sidebar keys and values
</dict>
<dict>
sidebar keys and values
</dict>

</array>

Understanding the Types of Sidebars
There are several types of sidebars, each with a specific purpose and set of keys:

Sidebar Type Description Related Section
static A list of URLs. “Static Unique Keys” on page 38
search A list of search results using tag- “Search Unique Keys” on

based or text-based searching.  page 40

calendar A list of upcoming events. “Calendar Unique Keys" on
page 41
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Sidebar Type Description Related Section

tag A list of search results using tag- “Tag Unique Keys” on page 42
based searching.

recentActivity A list of pages sorted by recent ~ “Recent Activity Unique Keys”on
viewing frequency. page 42

Based on the last 100 page
views in a wiki, this list displays
the most-viewed page first,
followed by the next most-
viewed, and so on.

admin A sidebar that appears if Not applicable
someone logs in as an admin.
This sidebar isn’t customizable.

Shared Keys
All sidebars require the following keys:

Key Example Values Possible Values Optional or Required  Description
displayName What's Hot, What's New, Any string Required Name of the sidebar.
Useful Links, Upcoming
Events
type search, static, calendar  static, search, calendar,  Required Type of sidebar used.
tag, recentActivity,
admin
uid HotList, RecentAddsList, Any string Required Identifier for the
UsefulLinks sidebar. This value must
be unique.

Static Unique Keys
Static sidebars list predefined URLs.“Useful Links”is an example static sidebar.

Static sidebars have the following keys:
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Key Example Value Possible Values Optional or Required

urls Not applicable An array of dictionary ~ Required
entries, each
representing a single

Description

Because links include
several values, such as
the name of the link

link and the URL, every link
is represented by a
dictionary entry.
headerURL http://example.com/ Fully qualified URL Optional A URL that is linked
groups/groupname/se to from the sidebar’s
arch/?sort=modifiedDa header.
te&kind=wiki&kind=w
eblog&kind=mailinglis
t&sortDirection=revers
e&excludePages=wiki/
welcome
feedURL feed://example.com/ Fully qualified URL Optional An RSS or Atom feed
groups/groupname/ that is associated with
search/index.rss?sort= the sidebar.
modifiedDate&kind=wi
ki&kind=weblog&kind=
mailinglist&sortDirectio
n=reverse&excludePage
s=wiki/welcome
Each dictionary entry has the following keys:
Key Example Value Possible Values Optional or Required  Description
kind url url, wiki, weblog, Required Not used in any themes.

mailinglist, calendar

Use this to assign a
class to a sidebar.

You can then use the
class selector in CSS

to customize sidebars,
such as by adding small
calendar icons next to
calendar sidebar links or
small Safari icons next
to URL links.

subtitle Your server’s homepage, Any string Required
List of groups with wikis
on this server

Appears under the
name of the link.

title Server Home, Groups Any string Required

Name of the link.
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Key Example Value Possible Values Optional or Required  Description

uid serverhome, groups Any string Required Identifier for the URL.
This value must be
unique.

url /,/groups/ A relative or absolute Required Contents of the link.

path to a web page

snippet Click here to see your  Any string Optional
server’'s homepage.

Used for the link’s tool
tip.

To enable tool tips,
comment out the
following block in the
theme’s grouphome.
css file:

.grouphome
.snippet{

display:none;

Search Unique Keys

Search sidebars list search results using tag-based or text-based searching. "What's

Hot” and “What's New” are examples of search sidebars.

Search sidebars have the following unique keys:

Key Example Value Possible Values Optional or Required  Description

howMany 5 Any number, 1 or more  Required Maximum number of
entries in the sidebar.

tag hot One or more strings in ~ Optional The tags associated

the same array

with this sidebar. Pages
using all of these tags
are added to this
sidebar.

kind wiki, weblog, mailinglist  One or more of the Optional
following in the same
array:
- all
+ wiki
- weblog
-+ mailinglist
- calendar

The kinds of pages
associated with this
sidebar. A search only
lists pages of these
types.

If this key isn't provided,
all types of pages

can be shown in the
sidebar.
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Key Example Value Possible Values Optional or Required  Description
q annejohnson, wiki, One or more strings in ~ Optional The text query used to
2008-03-17 the same array search for entries.

fields title, content, author One or more of the Optional The fields the text
following in the same query is applied to.
array: If the query matches
. title any of these fields, the
« author entry appears in the

+ authorLongName
- lastModifiedAuthor

sidebar.

sort modifiedDate, One or more of the Optional Entries are sorted based
createdDate, title, following in the same on these fields.
author array: The first field listed is

- title sorted first, then the

+ author entries are resorted by

- authorLongName subsequent fields.

« lastModifiedAuthor The last field listed
takes precedence over
previously listed fields.

sortDirection reverse forward or reverse Optional Sorting order of entries.
reverse—most recently
modified page is listed
first.
forward—Ileast recently
modified page is listed
first.

emptyListString There are no matches.  Any string Optional Shown when there are

no matching search
results.

Calendar Unique Keys

Calendar sidebars list upcoming events.“Upcoming Events”is an example calendar

sidebar.

Calendar sidebars have the following unique keys:
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Key Example Value Possible Values Optional or Required  Description

howManyDays 5 Any number, 1 or more  Required Maximum number of
days until an event
for it to be listed in
the sidebar. Events
occurring after this
number of days aren't
shown in the sidebar.

emptyListString There are no matches.  Any string Optional Shown when there are
no matching calendar
events.

Tag Unique Keys
Tag sidebars list wiki, blog, and mailing list entries that use a specific tag or set of tags.
The most recently modified entries are listed first.

Tag sidebars have the following unique keys:

Key Example Value Possible Values Optional or Required  Description
tag hot A single string or Required Tags associated with
several strings in the the sidebar. Pages using
same array all of these tags are
added to the sidebar.
howMany 5 Any number, 1 or more  Required Maximum number of

entries in the sidebar.

emptyListString There are no matches.  Any string Optional Shown when there are
no matching search
results.

Recent Activity Unique Keys
Recent activity sidebars list pages that had the most readers recently.
Recent activity sidebars have the following unique keys:

Key Example Value Possible Values Optional or Required  Description

howMany 5 Any number, 1 or more  Required Maximum number of
entries in the sidebar.

emptyListString There are no matches.  Any string Optional Shown when there are
no matching search
results.

Overview of the Example Sidebars
The wireframe theme's theme.plist file provides several example sidebars:
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Sidebar Name Description

What's Hot Lists the five most recently modified pages
tagged with “hot.”

What's New Lists the five most recently created pages. This
includes wiki, weblog, and mailing list pages.

Useful Links Lists several predefined links.

Upcoming Events Lists events occurring within the next five days.

Using the Example Sidebars

The wireframe theme’s theme.plist file includes several sidebar examples. All of these
examples are commented out by default. You must remove the comments marks if
you want to use the example sidebars as custom sidebars. If you don’t add custom
sidebars, the default sidebars are used. If you use at least one custom sidebar, the
default sidebars don't appear.

Consider commenting out all sidebars you don’t want to use, and leaving
uncommented all sidebars you want to use. Doing this allows you to choose which
sidebars you want and allows you to easily change sidebar settings later on.

To do this, start a comment before the <dict> tag for a sidebar, and end the comment
after the </dict> tag for that sidebar.

To view specific sidebars:
In Terminal, enter the following command:
$ cd /Library/Application\ Support/Apple/WikiServer/Themes/

If you want to use a non-command-line tool, copy the theme.plist file to your
Documents folder.

To copy this file, enter:

$ cp theme name.wikitheme/theme.plist /Users/user name/Documents/

Replace theme_name with the name of the theme. Replace user_name with the short
name of the user you're logged in as.

Open theme.plist in a text editor.
To open this file in a command-line text editor, enter:

$ sudo nano theme name.wikitheme/theme.plist

If prompted, enter your administrator account password.

You can use any command-line text editor, as long as you precede the command to
run the text editor with sudo.

If you're using a non-command-line tool, open the theme.plist file located in your
Documents folder.
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4 If there is a <!-- comment marker before <keys>sidebars</key>, remove it and the -->
comment marker before <key>version</key>.

5 For each sidebar that you want to comment out, do the following:
a Add <!-- before the <dict> tag of the sidebar you want to comment out.
For sidebars, <dict> tags are followed by the displayName key.

For example, to comment out the “What’s Hot” sidebar, you'd change this:
<dict>

<key>displayName</key>

<string>What’s Hot</string>

to this:

<!--

<dict>

<key>displayName</key>

<string>What’s Hot</string>

b Add --> after the </dict> tag of the sidebar you want to comment out.

The corresponding </dict> tag is the first one found at the same indentation level
of the sidebar’s <dict> tag.

For example, to finish commenting out the “What'’s Hot” sidebar, you'd look for the
first </dict> tag at the same indentation level as the What's Hot <dict> tag level,
and then youd change this:

</dict>
to this:

</dict>

-—>

6 If you copied theme.plist to your Documents folder, copy it back to the theme folder.
To copy this file, enter:
$ cp /Users/user name/Documents/theme.plist theme name.wikitheme/

7 Restart web service.

For more information, see “Starting Up Web Service” on page 21.

Adding JavaScript and XSL Files

The wiki server supports the use of custom JavaScript and Extensible Stylesheet
Language (XSL) files. JavaScript and XSL change the content you're displaying, whereas
CSS controls the presentation of content. For example, you use could use JavaScript or
XSL to add a“digg it” link to your blog entries, which would then tie the blog entries to
digg.com.

Carefully choose whether you want to use JavaScript, XSL, or both.
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JavaScript has these advantages:

+ Unlike custom XSL files, JavaScript files continue to work after doing a software
update. The wiki server includes XSL files, which can be changed during a software
update. If these files change, an error occurs because the file versions of included
files no longer match the file versions of custom XSL files.

« JavaScript can allow you more control over a document than XSL if you have access
to information on the server that isn't provided in the XSL context.

XSL has this advantage:

+ XSL transformations are performed on the wiki server, so the user’s browser isn't
required to support and run it.

To add JavaScript files or XSL files to a theme:

Put JavaScript (.js) files or XSL (.xsl) files in this folder (shown below):

/Library/Application Support/Apple/WikiServer/Themes/theme_name/

Replace theme_name with the name of the theme.
/Library/Application Support/Apple/WikiServer/Themes/
theme_name/

|
— JavaScript files

— XSL files

Restart web service.

For more information, see “Starting Up Web Service” on page 21.

About JavaScript
JavaScript is a lightweight, object-oriented, cross-platform scripting language.

Wiki server pages include the prototype.js and script.aculo.us frameworks, which
enhance and streamline the use of JavaScript.

For more information, see the following:

Topic URL
JavaScript developer.mozilla.org/en/docs/JavaScript
quirksmode.org/js/contents.html

crockford.com/javascript/javascript.html

prototype.js prototypejs.org/api

scriptaculo.us wiki.script.aculo.us
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Here are some published JavaScript guides:

« JavaScript: The Definitive Guide, 5th Edition, by David Flanagan. O'Reilly Media, Inc.
2006.

« Beginning JavaScript with DOM Scripting and Ajax: From Novice to Professional, by
Christian Heilmann. Apress. 2006.

JavaScript Example

The following example JavaScript function adds a header link next to the magnifier
button that points to www.apple.com and changes the “Other Wikis” link to point to
www.apple.com:

Event.observe (window, 'load', function() {
// add another header link (to apple.com) by manipulating the DOM
// using script.aculo.us Builder
// we'll just insert it before the search button
if ($('linkSearch')) {
$('linkSearch') .parentNode.insertBefore (Builder.node('1i",
{id:'linkApple'}, [
Builder.node('a', {href:'http://www.apple.com'}, 'apple')
1), $('linkSearch'));
}
// change the Other Wikis link to something else

if ($('groups users button')) {
$ ('groups users button').down('a').href = 'http://www.apple.
com/";

}
}) i

To use this example JavaScript code, save it as a .js file in this folder:

/Library/Application Support/Apple/WikiServer/Themes/theme_name/

About XSL

XSL defines XML document transformation and presentation. For information about
XSL, see www.w3.org/Style/XSL/.

The wiki server uses a set of XSL files located at:
/usr/share/wikid/lib/apple_templates/

Because a software update can overwrite files in /usr/share/wikid/lib/apple_templates/,
edit the copies of these XSL files located in:

/Library/Application Support/Apple/WikiServer/Themes/theme_name/

XSL files in this location override XSL files in /usr/share/wikid/lib/apple_templates/.
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If a software update overwrites the files in /usr/share/wikid/lib/apple_templates/, you
must manually merge the changed contents of your customized XSL files with the
updated XSL files. If you don't merge the contents, the versions won't match and an
error will occur.

If you edit a copy of the default.xsl file, you must also make copies of all XSL files
that include the original default.xsl file and then change them to include the edited
default.xsl file.

Viewing Dynamic XML
The wiki server dynamically generates XML content, which is called context. Context is
transformed by XSL files into HTML.

Before you view context, familiarize yourself with the XSL files located in:
/usr/share/wikid/lib/apple_templates/

The XSL files correspond to specific pages in the wiki. For example, a group’s wiki
homepage uses grouphome.xsl, while a typical wiki page uses content_entry.xsl. To
view context, create an XSL file that displays context and put it in your theme’s folder.
This overrides the XSL files in /usr/share/wikid/lib/apple_templates/ and changes the
output for the pages that they correspond to.

To view context:
Create a plain text file with the following content:
<?xml version="1.0" encoding="UTF-8" ?>
<xsl:stylesheet version="1.0"
xmlns:xsl="http://www.w3.0rg/1999/XSL/Transform">
<xsl:output
method="html"
version="1.0"
encoding="UTF-8"
indent="yes"
doctype-public="-//W3C//DTD HTML 4.01//EN"
doctype-system="http://www.w3.0rg/TR/html4/strict.dtd"/>
<xsl:template match="page">
<xsl:copy-of select="context"/>
</xsl:template>

</xsl:stylesheet>

Save the file in this location:
/Library/Application Support/Apple/WikiServer/Themes/theme_name/
Use the same filename as any of the XSL files located in:

/usr/share/wikid/lib/apple_templates/
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Choose a filename based on the page with the context you want to view. For
example, to view the context for the group’s wiki homepage, change the filename to
grouphome.xsl.

Restart web service.
For more information, see “Starting Up Web Service” on page 21.
In a web browser, load a page that uses the XSL file, and then view the page’s source.

To view a page’s source in Safari, load the page and choose View > View Source.

Customizing My Page
Similar to customizing wikis by applying themes, you can customize the theme for My
Page or change text on My Page without applying a theme.

Changing Text Shown in Wikis and Blogs Lists
You can change text found in the wikis and blogs lists on My Page without editing a
theme. This text appears in the sidebar at the right of the lists.

To change text shown in the wikis list:

In Terminal, enter the following command:

$ cd /Library/Application\ Support/Apple/WikiServer/
Create a file named wikiListExplanation.html in a text editor.
To create this file in a command-line text editor, enter:

$ sudo nano wikiListExplanation.html

If prompted, enter your administrator account password.

You can use any command-line text editor, as long as you precede the command to
run the text editor with sudo.

Enter the content that you want to appear in HTML format and save it.

For example, here’s some HTML:

<p>These are private wikis for <a href="http://www.example.com">Example
Co.</a></p><p>If you can't create wikis but you'd like to, contact
the <a href="mailto:svradmin@example.com">Server Administrator</
a>.</p>

Change the permissions of wikiListExplanation.html by entering the following
command:

$ sudo chown 94:94 wikilListExplanation.html

To change the text shown in the blogs list:

In Terminal, enter the following command:

$ cd /Library/Application\ Support/Apple/WikiServer/
Create a file named userListExplanation.html in a text editor.
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To create this file in a command-line text editor, enter:
$ sudo nano userListExplanation.html
If prompted, enter your administrator account password.

You can use any command-line text editor, as long as you precede the command to
run the text editor with sudo.

Enter the content that you want to appear in HTML format and save it.

For example, here’s some HTML:

<p>These are personal blogs for <a href="http://www.example.com">Example
Co.</a></p><p>If you can't create a personal blog but you'd like
to, contact the <a href="mailto:svradmin@example.com">Server
Administrator</a>.</p>

Change the permissions of userListExplanation.html by entering the following
command:

$ sudo chown 94:94 userListExplanation.html

Changing the My Page Theme
You can create your own theme for My Page or edit the provided example My Page
theme.

When you create a custom theme, your theme overrides the default My Page theme.
For example, if you change the background color and the body text font in the custom
theme CSS, My Page will use the custom theme's background color and body text
font but it will use the default My Page theme for everything else. Similarly, custom
JavaScript functions override default My Page functions of the same name.

The provided example theme changes the background color of My Page.

To create a copy of the example My Page theme with permissions intact:
In Terminal, enter the following commands:

$ cd /Library/Application\ Support/Apple/WikiServer/Themes/

$ sudo ditto toplevel.wikitheme/ theme name.wikitheme/

Replace theme_name with the name of the theme you're creating.
If prompted, enter your administrator account password.

Restart web service.

For more information, see “Starting Up Web Service” on page 21.
To edit a My Page theme from the command line:

In Terminal, enter the following commands:

$ cd /Library/Application\ Support/Apple/WikiServer/Themes/theme name.
wikitheme/

Replace theme_name with the name of the My Page theme you're editing.
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If prompted, enter your administrator account password.

To change how My Page looks, edit the screen.css file:
sudo nano screen.css

If prompted, enter your administrator account password.

You can use any command-line text editor, as long as you precede the command to
run the text editor with sudo.

To add JavaScript functions, edit the example.js file:
sudo nano example.js

If prompted, enter your administrator account password.

You can use any command-line text editor, as long as you precede the command to
run the text editor with sudo.

Restart web service.

For more information, see “Starting Up Web Service” on page 21.

To edit a My Page theme in a non-command-line tool:

In Terminal, enter the following:

cd /Library/Application\ Support/Apple/WikiServer/Themes/
Copy the My Page theme to your Documents folder by entering:

$ cp -r theme name.wikitheme/ /Users/user name/Documents/theme name.
wikitheme/

Replace theme_name with the name of the My Page theme you're editing.
Edit the contents of the theme name.wikitheme folder in your Documents folder.

To change how My Page looks, edit screen.css. To change JavaScript functions, edit
example,js.

Copy the folder back into the main Themes folder.
To copy, enter:

$ cp -r /Users/user name/Documents/theme name.wikitheme/ theme name.
wikitheme/

Restart web service.

For more information, see “Starting Up Web Service” on page 21.
To choose which My Page theme is shown:

In Terminal, enter the following command:

sudo nano /etc/wikid/wikid.conf

If prompted, enter your administrator account password.

You can use any command-line text editor, as long as you precede the command to
run the text editor with sudo.
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Edit the following lines and save the file:

<key>topLevelTheme</key>

<string>theme name</string>

Replace the theme_name value with the name key’s value in the custom theme’s
theme.plist. The example theme’s name is com.example.toplevel.

If there is no topLevelTheme key and value pair, add them.
Restart web service.

For more information, see “Starting Up Web Service” on page 21.

Testing Wiki Code Changes
You can test CSS, XSL, and JavaScript files by entering debug mode in the wiki and
then using the Inspector in Safari or the Firebug plugin for FireFox.

Debug mode uses uncompressed scripts and allows the code to be viewed in
debugging applications. Entering debug mode only applies to you and doesn't affect
anyone else using the wiki.

For information about Firebug, see the Firebug home page at https://addons.mozilla.
org/en-US/firefox/addon/1843.

To run the wiki in debug mode:

Enter this URL in your web browser:
http://wikiserverurl/collaboration/debugMode.html
Click Use Debug Mode.

To enable and use the Inspector in Safari:

If the Develop menu is not shown, choose Safari > Preferences; then, in Advanced,
select “Show Develop menu in menu bar.”

Browse to a page that has code you'd like to test.

Choose Develop > Show Web Inspector.

Click the disclosure triangles next to the types of files youd like to view, then select the

files to view them.
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Allowing Specific Protocols,

CSS Styles, and HTML Tags
and Attributes

Learn how to enable specific protocols, CSS styles, and HTML
tags and attributes.

The default wiki server setup simplifies administration by removing potentially harmful
protocols, CSS styles, and HTML tags and attributes. The wiki server can allow all
protocols, CSS styles, and HTML tags and attributes.

The wiki server uses two whitelist files (a built-in whitelist and a custom whitelist) to
determine allowed protocols, CSS styles, and HTML tags and attributes. Elements that
appear in either whitelist are allowed, and all other elements are disallowed.

The built-in whitelist includes common, usually harmless, elements. It doesn't include
potentially harmful tags like embed, param, object, and script. To embed Flash or
YouTube in your site, you must include some of these tags. If you create a custom
whitelist, you can allow these elements, along with new styles (such as font-size) and
protocols (such as irc and scp).

These whitelists affect all wikis on the server.

WARNING: Some protocols, HTML tags, and attributes can compromise your
server’s security and integrity, or harm users who connect to your server. Make sure
you understand the implications of whatever you enable. For example, allowing
JavaScript introduces security vulnerabilities such as cross-site scripting. For
information about cross-site scripting, see http://en.wikipedia.org/wiki/Cross-site_
scripting.

Creating a Custom Whitelist

To create a custom whitelist, create a plain text file named whitelist.plist in:
/Library/Application Support/Apple/WikiServer/

The following sections describe this example whitelist.plist file in detail:

<?xml version="1.0" encoding="UTF-8"?>
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<!DOCTYPE plist PUBLIC "-//Apple//DTD PLIST 1.0//EN" "http://www.apple.
com/DTDs/PropertyList-1.0.dtd">

<plist version="1.0">
<dict>
<key>protocols</key>
<array>
<string>irc</string>
<string>scp</string>
</array>
<key>styles</key>
<array>
<string>font-size</string>
</array>
<key>tags</key>
<dict>
<key>object</key>
<array>
<string>width</string>
<string>height</string>
</array>
<key>param</key>
<array>
<string>name</string>
<string>value</string>
</array>
<key>embed</key>
<array>
<string>src</string>
<string>type</string>
<string>width</string>
<string>height</string>
</array>
</dict>
</dict>
</plist>

About the Custom Whitelist’s Structure
The following lines are required in the custom whitelist:
<?xml version="1.0" encoding="UTF-8"?>

<!DOCTYPE plist PUBLIC "-//Apple//DTD PLIST 1.0//EN" "http://www.apple.
com/DTDs/PropertyList-1.0.dtd">

<plist version="1.0">

<dict>
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<key>protocols</key>
<array>
allowed protocols
</array>
<key>styles</key>
<array>
allowed CSS styles
</array>
<key>tags</key>
<dict>
allowed HTML tags and attributes
</dict>
</dict>
</plist>

Replace allowed protocols, allowed CSS styles, and allowed HTML tags and attributes with
values described in the following sections.

The dict contains several key/value blocks that allow specific protocols, styles, tags, or
attributes.

Allowing Specific URL Protocols
To allow specific URL protocols, add strings with the protocols’ names to the protocols
block.

For example, to allow entry of URLs that start with “irc://” and “scp://; create the
following block:
<key>protocols</key>
<array>
<string>irc</string>
<string>scp</string>

</array>

Allowing Specific CSS Styles
To allow specific CSS style attributes, add strings with the style attributes’ names to the
styles block.

For example, to allow the use of the font-size style attribute, create the following block:

<key>styles</key>
<array>
<string>font-size</string>

</array>

To allow the HTML “style” attribute, add the “style” attribute to the “_all_"tag, which is
described in the following section.
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Allowing Specific HTML Tags and Attributes

YouTube, Flash, and other advanced web formats usually require HTML tags and
attributes that aren’t allowed by default. For example, YouTube requires the following
tags and attributes:

Tag Attributes

object width, height

param name, value

embed src, type, width, height

Because these HTML tags or attributes aren’t included in the built-in whitelist, you
must add them to the custom whitelist.

To allow specific HTML tags and attributes:
1 Create a tags key and follow it with a dict.

2 In the dict, create keys named after the HTML tags.
To allow a specific attribute for all HTML tags, create a key named “_all_"

3 After each key, create string arrays listing allowed tag attributes.

For example, to support YouTube, create the following block:
<key>tags</key>
<dict>
<key>object</key>
<array>
<string>width</string>
<string>height</string>
</array>
<key>param</key>
<array>
<string>name</string>
<string>value</string>
</array>
<key>embed</key>
<array>
<string>src</string>
<string>type</string>
<string>width</string>
<string>height</string>
</array>

</dict>
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About the Built-in Whitelist
You can't change the built-in whitelist. However, a software update could change the
allowed elements in the built-in whitelist.

Protocols Allowed in the Built-in Whitelist
The built-in whitelist allows these protocols:

Protocol

afp

feed

feeds

fax

ftp

gopher

http

https

itms

itpc

Idap

mailto

news

nfs

nntp

rdar

rtsp

sip

sips

sftp

smb

ssh

svn

svn+ssh

tel
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Protocol

telnet

vnc

webcal

Xxmpp

CSS Styles Allowed in the Built-in Whitelist
The built-in whitelist allows these CSS styles:

Style

text-decoration

font-weight

font-style

HTML Tags and Attributes Allowed in the Built-in Whitelist
The built-in whitelist allows these HTML tags and attributes:

Tag Attributes

_all_ class, title

a href, name, ref

b

blockquote cite
body
br

caption
dd
div
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Tag Attributes
h4

h5

h6

html

img sr¢, alt, name, width, height, longdesc

node

ol

pre

q cite

span

strong

table

tbody

tfoot

th colspan, rowspan

thead

td colspan, rowspan

tr

ul
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Allowing Specific File Types for
Quick Look

Learn how to enable Quick Look for specific file types.

Quick Look allows users to preview a file without downloading the file. To use Quick
Look, click the eye button next to attachments.

When a file is attached to a wiki or blog page, the wiki server checks to see if the file
type is in the allowed whitelist for Quick Look files. If the file type is allowed and is
something that can be represented as a series of images (such as a Pages document, a
PDF, or a Keynote presentation), the wiki server creates an image for each page in the
file. When the user uses Quick Look, he or she views the series of images created by
the wiki server, not the file.

The built-in whitelist includes all file types that have Quick Look support by default in
Mac OS X. It doesn't include potentially harmful file types. To add file types that are not
included in the white list, such as third-party application file types, add them to the
white list.

WARNING: Some file types can compromise your server’s security and integrity,
or harm users who preview files. Make sure you thoroughly test the file types you
enable and review potential security issues.

About the Whitelist

The Quick Look whitelist is located at /etc/wikid/quicklook.conf.
By default, it supports the following file extensions:

File Extension

bmp

doc

docx
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gif
html

icns

ics

jpeg

jrg

key

mov

mpeg

mpg

mp3

mp4

m4a

mav

3gp

numbers

pages
pdf

png

ppt

ppix

psd

rtf

tif

tiff

txt

xhtml

xls

xlsx
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Adding Quick Look Support for File Types

To support additional file types in Quick Look, install the application’s Quick Look
generator and add the file type to the Quick Look whitelist. An application’s Quick
Look generator is usually installed when you install the application.

To add Quick Look support for more file types:

Install the application associated with the file type.

If you want to remove the application but keep its Quick Look generator, back up
the contents of /Library/QuickLook/, uninstall the application, and then restore
/Library/QuickLook/.

In Terminal, enter the following command:

$ sudo cp /etc/wikid/quicklook.conf.default /etc/wikid/quicklook.conf
If prompted, enter your administrator account password.

Open /etc/wikid/quicklook.conf in a text editor.

To open this file in a command-line editor, enter:

sudo nano /etc/wikid/quicklook.conf

If prompted, enter your administrator account password.

You can use any command-line text editor, as long as you precede the command to
run the text editor with sudo.

Add the file type’s extension as a string in the array for the supportedExtensions key.

For example, if your file type’s extension is “xyz,” the supportedExtensions array should
look similar to this:

<key>supportedExtensions</key>
<array>
<string>xyz</string>

<string>bmp</string>

</array>
If your file type is a bundle, add the extension as a string in the array for the bundles
key.
For example, if your file type’s extension is “xyz” and is a bundle, the bundles array
should look similar to this:
<key>bundles</key>
<array>
<string>xyz</string>

<string>pages</string>

</array>

Save /etc/wikid/quicklook.conf.
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8 Restart web service.

For more information, see “Starting Up Web Service” on page 21.
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Managing Wiki Content

Learn how to manage wiki content using tools and the
command line.

Using tools and the command line allows you to migrate, back up, and edit raw wiki
content.

Migrating Wiki Content from Other Websites

AppleWikilmporter is a tool that can traverse a website that has a page listing all other
pages on the site and create wiki pages based on the website contents. If the website
uses tags, AppleWikilmporter can import those tags.

To use this tool, you need some knowledge of CSS selectors and, depending on the
website you're importing, some knowledge of JavaScript.

AppleWikilmporter is located at:

https://connect.apple.com/cgi-bin/WebObjects/MemberSite.woa/wa/
getSoftware?bundlelD=19994

For information about using AppleWikilmporter, see its readme file.

Backing Up the Wiki Server

If you installed Mac OS X Server using a standard or workgroup configuration, you can
use Time Machine to automatically back up the wiki server. If you installed Mac OS X
Server using an advanced configuration and haven’t changed the default wiki and
calendar data store locations, Time Machine also automatically backs up your wiki
server.

If you don't use Time Machine, the following information describes how you can
manually back up the wiki server.

Wiki content is stored in a data store. The default location is /Library/Collaboration/.
You can change this location using Server Admin (in web service).
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To manually back up the wiki, copy the wiki data store with its permissions intact. For
example, to copy the wiki data store to a folder on another volume, enter the following
in Terminal and authenticate as an administrator when requested:

sudo ditto /Library/Collaboration/ /Volumes/volumename/foldername/

If you created or edited themes, copy the theme folder with its permissions intact. To
copy the themes folder to a folder on another volume, enter the following in Terminal
and authenticate as an administrator when requested:

sudo ditto /Library/Application\ Support/Apple/WikiServer/ /Volumes/
volumename/foldername/
If you're using the web calendar, you must back up the calendar data store. The default

location is /Library/CalendarServer/Documents/. You can change this location using
Server Admin (in iCal service).

To manually back up the calendar, copy the calendar data store with its permissions
intact. For example, to copy the calendar data store to a folder on another volume,
enter the following in Terminal and authenticate as an administrator when requested:

sudo ditto /Library/CalendarServer/Documents/ /Volumes/volumename/
foldername/

Moving Wiki Content

There are a few ways to move wiki content depending on if you're moving wiki
content between drives on the same server, or if the new and original servers have the
same hardware configuration.

Moving the Wiki Server Volume from One Drive to Another
If you're moving the wiki server volume from one drive to another on the same server,
the server must meet the following requirements:

+ Wiki service must be offline while moving content.

« The server must have an additional volume with Mac OS X or Mac OS X Server
running.

+ The server must have a volume that can be erased and have more space available
than the size of the original volume.

To move wiki server volume from one drive to another on the same computer:

Load Mac OS X or Mac OS X Server on a volume that is not running wiki service.

You can change your startup volume using Startup Disk System Preferences or by
pressing and holding Option while your server is starting up.

Open Disk Utility located in /Applications/Utilities/.

Select a drive in the list on the left.
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In the Restore pane, drag the wiki server volume to the Source field, and then drag the
new volume that will host the wiki server to the Destination field.

Select “Erase destination” and click Restore.

While Disk Utility is restoring volumes, don't modify the new or old volumes.

Restart the server by opening Startup Disk System Preferences, selecting the new
volume hosting the wiki server, and then clicking Restart, or by restarting the server
and pressing and holding Option and selecting the new wiki server volume.

Moving a Wiki Server Volume from One Server to Another with the
Same Hardware Configuration

If two servers have the same hardware configuration, you can use Disk Utility to
duplicate the original wiki server volume to a volume on the new server.

If you're moving the wiki server volume from one server to another, the servers must
meet the following requirements:
+ The wiki server must be offline while moving content.

+ The original or new server must have an additional volume with Mac OS X or
Mac OS X Server running.

+ The new server must have a volume that can be erased and have more space
available than the size of the original wiki server volume.

+ The servers must connect using a FireWire cable.
If the new and original servers have the same hardware configuration:

On the original or new server, load Mac OS X or Mac OS X Server on a volume that is
not running wiki server.

Start the other server in target disk mode by pressing and holding T while the server is
starting up.

You can also open Startup Disk System Preferences, click Target Disk Mode, and then
click Restart.

Use a FireWire cable to connect the servers.
Open Disk Utility located in /Applications/Utilities/.
Select a drive in the list on the left.

In the Restore pane, drag the wiki server volume to the Source field and then drag the
new volume that will host the wiki server to the Destination field.

Select “Erase destination” and click Restore.
While Disk Utility is restoring volumes, don't modify the new or old volumes.

Restart the new server.
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Moving Wiki Content from One Server to Another with a Different
Hardware Configuration

If you're moving the wiki server volume from one server to another, the servers must
meet the following requirements:

+ The wiki server must be offline while moving content.

« The original or new server must have a volume with Mac OS X Server running.

+ The servers must connect using a FireWire cable.

« If you're moving the wiki server volume to an Xserve with a RAID card, you'll also
need an external hard drive.

To move content, do the following:

+ Prepare the original server for moving content.

+ On the new server, re-create the local directory domain with the same short names
as the old server.

« Connect the servers with a FireWire cable and start the original server in target
disk mode. If you're moving the wiki server volume to an Xserve with a RAID card,
connect an external hard drive to the original Xserve.

+ For every group wiki, copy the wiki content and modify group wiki files to fit the
new volume.

« Start wiki server on the new server.

To prepare the original server for moving content:

Stop web service if it is running.

In Server Admin, under the original server, select Web, and then click Stop Web.
Copy the contents of the original wiki server files to a backup location.

For more information, see “Backing Up the Wiki Server” on page 63.

To re-create the local directory directory domain:
In Workgroup Manager on the original server, click the small globe icon at the top left
and choose Local.

To export all users, click the single silhouette button, choose Edit > Select All, choose
Server > Export, enter a name for the export file, and click Export.

To export all groups, click the multiple silhouette button, choose Edit > Select All,
choose Server > Export, enter a name for the export file, and click Export.

In Workgroup Manager on the new server, click the small globe icon at the top left and
choose Local.

Choose Server > Import, select an exported file and click Import; then repeat this and
choose the other exported file.
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Passwords are removed when exporting and importing users. Tell users that they must
change their passwords.

To start the original server in target disk mode:
If you're moving the wiki server volume to an Xserve with a RAID card, connect an
external hard drive to the original server instead of doing this.

Use a FireWire cable to connect the servers.
Do one of the following:
+ Restart the original server and press and hold T while it is starting up.

+ On the original server, open System Preferences, click Startup Disk, click Target Disk
Mode, and then click Restart.

For every group, do the following in Terminal:
Copy group wiki content. Do one of the following:
« If the two servers are connected by a FireWire cable, enter this:

sudo ditto /Volumes/original server volume/Library/Collaboration/
Groups/group name/ /Library/Collaboration/Groups/group name/

« If you connected an external hard drive to the original server, enter this:

sudo ditto /Volumes/original server volume/Library/Collaboration/
Groups/group name/ /Volumes/external volume/Library/Collaboration/
Groups/group name/

Connect the external hard drive to the new server, and enter this:

sudo ditto /Volumes/external volume/Library/Collaboration/Groups/
group name/ /Volumes/new server volume/Library/Collaboration/Groups/
group name/

Find the new group GUID:
dscl /Search -read /Groups/group name dsAttrTypeNative:apple-generateduid

Open /Library/Collaboration/Groups/group_name/metadata.plist in a text editor and
replace the string listed after the GUID key with the new group GUID.

Delete the index.db file:

sudo rm /Library/Collaboration/Groups/group name/index.db
To start the wiki server:

On the new server, do one of the following:

« In Server Preferences, click Web and move the slider to On.

+ In Server Admin, open the disclosure triangle for your server, select Web, and click
Start Web.

« Enter the following in Terminal:

$ sudo serveradmin start teams;

If prompted, enter your administrator account password.
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Wiki File Structure Overview
By default, the wiki server stores group wikis in /Library/Collaboration/Groups/.

The illustration below shows group wiki files and folders.

| /Library/Collaboration/Groups/

\—¥ | group_name/
[ —

‘J

L
— index.db

\
— metadata.plist

L wiki/
| ~—
\—¥ page_uid.page/
_—
———  pagehtml
— page.plist
— attachments/

attachment_uid/

[ -
[
|
attachment_filename

L images/

1T

The Groups folder in the wiki data store includes the following critical wiki files and
folders:

image_filename

File or Folder Name Purpose

group_name/ Creating a wiki creates a folder with the group’s
short name.

group_name/index.db Changes when you edit wiki content. If you

manually edit raw content, erase this file so it
regenerates based on raw content.

group_name/metadata.plist Contains wiki administration settings.
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File or Folder Name Purpose

group_name/wiki/

Stores all pages in the wiki.

The blog uses a similar file structure. The blog
stores its pages in

group_name/wiki/page_uid.page/

This is created when you create a wiki page. The
name of the folder is a unique identifier that
appears in the page’s URL:

http://domain_name/groups/group_name/wiki/
page_uid/page_name

group_name/wiki/page_uid.page/page.html

Contains the page’s HTML content.

group_name/wiki/page_uid.page/page.plist

Contains meta-information for a page.

group_name/wiki/page_uid.page/attachments/

Stores subfolders for every attachment.

group_name/wiki/page_uid.page/attachments/
attachment_uid/

This is created when a file is attached to a page.
Every folder stores one attachment. The name of
the folder is a unique identifier that appears in
the attachment’s URL:

http://domain_name/groups/groupname/
wiki/pageuid/attachments/attachment_uid/
attachment_filename

group_name/wiki/page_uid.page/attachments/
attachment_uid/attachment_filename

This is an attachment.

group_name/wiki/page_uid.page/images/

Stores all images for a page.

group_name/wiki/page_uid.page/images/image_
filename

This is an image.

Manually Editing Raw Content

When you use the wiki to edit wiki pages, the wiki server indexes your content. If you
manually edit raw content, the wiki server doesn't index content. You must delete the
index.db file so the file regenerates based on the changed raw content; otherwise, an
error occurs.

To avoid this problem, use the Atom Publishing Protocol, also known as AtomPub, or
the MetaWeblog application programmer’s interface (API). You can use an AtomPub-
enabled client or the MetaWeblog API to log in, publish, update, or delete wiki and
blog entries.

Configure AtomPub clients to use this service address:
http://domain_name/groups/group_name/atompub

For more information about AtomPub, see:
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Website URL
RFC 4287:The Atom Syndication Format atompub.org/rfc4287.html
RFC 5023:The Atom Publishing Protocol tools.ietf.org/html/rfc5023

For more information about MetaWeblog API, see:

Website URL
RFC: MetaWeblog API http://www.xmlrpc.com/metaWeblogApi

To regenerate the index after editing raw wiki content:
Delete /Library/Collaboration/Groups/group_name/index.db by entering:
sudo rm /Library/Collaboration/Groups/group name/index.db

Replace group_name with the group’s short name.
Restart web service.

For more information, see “Starting Up Web Service” on page 21.

Viewing a Wiki's Administration Settings
The wiki’s admin settings are stored in:

/Library/Collaboration/Groups/group_name/metadata.plist
Replace group_name with the group’s short name.

For information about viewing or editing property list files, see “Editing Property List
Files” on page 32.

The metadata.plist file includes the following keys:

Key Example Value Description
GUID 28CC6BES-11C1-456C-A3B2- Uniquely identifies the wiki.
8FCF5520A1DB

This value must correspond to
the group record’s GUID in the
directory domain.

To view a group record's GUID,
use Workgroup Manager. For
more information, see User
Management at www.apple.
com/server/macosx/resources/.

LongName Wiki Name Name of the wiki. By default, this
name appears in the top left of
every wiki page.

allowComments <true/>, <false/> Set to true if comments are
allowed.
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Key

Example Value

<true/>, <false/>

Description

Set to true if comments from
anyone are allowed. Set to

false if only comments from
authenticated users are allowed.

allowUnmoderatedComments

<true/>, <false/>

Set to true if comments
from authenticated users are
unmoderated.

<true/>, <false/>

Set to true if comments from
unauthenticated users are
unmoderated

bannerlmage

/groups/group_name/public/
image_filename

Path to the banner image.

indexVersion

2

Don't change this value.

name

group_name

Short name of the group.

podcastCategory

Sports, Music

Name of the podcast category.

podcastEnabled

<true/>, <false/>

Set to true if podcasts are
enabled.

sidebars

An array

Contains custom sidebar
settings.

For more information about
setting up sidebars, see
“Creating Sidebars” on page 37.

themeName

com.apple.block.green.banner

Set to the unique identifier of
the theme.

Use the Admin Settings page to change these settings instead of manually editing
the metadata.plist file. If you manually edit the file, you must stop web service or your
changed settings are overwritten.

To manually edit wiki administration settings:
Stop the web service by doing one of the following:

« In Server Preferences, click Web and move the slider to Off.

+ In Server Admin, open the disclosure triangle for your server, select Web, and click

Stop Web.

+ Enter the following in Terminal:

$ sudo serveradmin stop teams;

If prompted, enter your administrator account password.

Stopping web service can disrupt users, so send out a notification that the server will
be temporarily down before doing this.
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If you're going to use Property List Editor or a non-command-line tool, copy the
theme.plist file to your Documents folder.

To copy this file, enter:

$ sudo cp /Library/Collaboration/Groups/group name/metadata.plist /Users/
user name/Documents/

Replace group_name with the group’s short name. Replace user_name with the short
name of the user you're logged in as.

If prompted, enter your administrator account password.
Open theme.plist in Property List Editor or in a text editor.
To open this file in a command-line text editor (in this example, nano), enter:

$ sudo nano theme name.wikitheme/theme.plist

If prompted, enter your administrator account password.

You can use any text editor, as long as you precede the command to run the text
editor with sudo.

If you're using Property List Editor or a non-command-line tool, open the theme.plist
file located in your Documents folder.

For information about Property List Editor, see “About Property List Editor” on page 33.

Edit theme.plist and save your changes.

5 If you copied theme.plist to your Documents folder, copy it back to the theme folder.

To copy this file, enter:
$ sudo cp /Users/user name/Documents/theme.plist theme name.wikitheme/

If prompted, enter your administrator account password.
Start the web service by doing one of the following:

« In Server Preferences, click Web and move the slider to On.

+ In Server Admin, open the disclosure triangle for your server, select Web, and click
Start Web.

+ Enter the following in Terminal:

$ sudo serveradmin start teams;

If prompted, enter your administrator account password.

Viewing a Page’s Metainformation
A page’s metainformation, such as its title, last author, and last modification date, are
stored in:

/Library/Collaboration/Groups/group_name/wiki/page_uid.page/page.plist
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Replace group_name with the group’s short name. Replace page_uid with the unique

identifier of your page.

Blog and mailing list archive pages have their own page.plist file.

For information about viewing or editing property list files, see “Editing Property List

Files” on page 32.

The page.plist file includes the following keys:

Key

author

Example Value

annejohnson

Description

Short user name of the original
author.

commentUID

groups/group_name/discussion/
page_uid

Unique identifier for the
comments page and its location.

createdDate 2008-02-19T718:58:47Z Original page creation date and
time.

edited <true/>, <false/> Originally set to false, this is set
to true the first time the page
is saved.

kind wiki, weblog, mailinglist Type of page.

lastModifiedAuthor ravipatel Short user name of the last

person to edit the page.

modifiedDate

2008-03-20T23:49:19Z

Last page modification date and
time.

title Welcome Title of the page.

tombstoned <true/>, <false/> Originally set to false, this is
set to true when a page is
temporarily deleted.
If a page is permanently deleted,
the entire page_uid.page/ folder
is removed.

uid groups/group_name/wiki/ Unique identifier for the wiki

page_uid/ page and its location.
versioned <true/>, <false/> Wiki pages are versioned; blog

and mailing list entries aren't.

After manually editing this file, delete the group’s index.db file and restart the server.
For more information, see “Manually Editing Raw Content” on page 69.

Managing Attachments

When a user attaches a file to a wiki page, that file is stored in:
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/Library/Collaboration/Groups/group_name/wiki/page_uid.page/attachments/
attachment_uid/

Group_name is the group’s short name. Page_uid is the unique identifier of the page
that the file is attached to and attachment_uid is the unique identifier of the file. Both
unique identifiers are included in the attachment’s URL:

http://domain_name/groups/group_name/wiki/page_uid/attachments/attachment _
uid/filename

If someone deletes or replaces an attachment in the wiki, the old attachment remains
on the server. This allows use of the wiki’s history feature to restore old versions of
attached files.

If you delete the folder containing the attachment on the server, users can't restore the
attachment.

Configuring Wiki Server Settings From the Command Line
Wiki Server settings are stored in /etc/wikid/wikid.conf.

These settings affect all wikis and blogs hosted on the server.

WARNING: The wikid.conf file contains many critical keys, with values that must be
entered correctly. Back up the wikid.conf file and any other critical Wiki Server files
before editing wikid.conf.

The wikid.conf file includes many keys, some of which you should not edit. You can
edit the following keys, but be careful when doing so:

Key Default Value Description

repositoryPath /Library/Collaboration Path to the wiki server data
storage.

loggingPath /Library/Logs/wikid Path to wiki server log files.

maxAttachmentSize 52428800 Maximum size for an

attachment in bytes.
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Key

logLevel

Default Value

info

Description

Set to how much information
you want logged.

Can be one of the following:
. err

- warn

« msg

- info

- debug

defaultTheme

com.apple.snowleopard

Set to the unique identifier of
the default theme.

enableClearTextAuth

<false/>

Set to true to enable clear text
authentication.

Use this if your directory system
doesn't support MD5 hash
pasword authentication.

mailServer

host.example.com

URL of the mail server that the
wiki server manages.

hostnameForMailingLists

example.com

Set this to the server address
appended to mailing list email
addresses.

serverTitle

Mac OS X Server

Title of the root page and all
pages in My Page.
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Key Default Value Description

longSessionTimeout 1209600 Number of seconds of inactivity
allowed before a user must log
in again.

accessLogEnabled <true/> Set to true to enable the access

log.

accessLogFormat

%(remoteHost)s - %(username)
s [%(timeStamp)s]
"%(httpMethod)s %(uri)s
HTTP/%(clientProtocolVersion)
s" %(httpCode)d %(bytesSent)s
"%(referrer)s" "%(userAgent)s"

Format for each entry in the
access log.

Allowed values include:

+ g(queryingHost)s

+ gp(remoteHost)s
requestHost)s

+ gp(sessioniD)s

* %

.
X

(
(
(
(
(username)s
(timeStamp)s
- op(timeTaken)s
(
%(
(
(
(
(
(

.
o\°

userAgent)s

.
X

0
« opreferrer)s

+ op(bytesSent)d
httpCode)d
httpMethod)s

uri)s

« gp(clientProtocolVersion)s

.
X

0

..
X R

serverRPCRedirect

/RPC2

Enter the hostname for RPC
communication. This allows you
to hide multiple wiki-servers
behind one master web host.

topLevelTheme com.example.my_theme Enter the unique identifier of
the theme for My Page.

mailFlushinterval 600 Number of seconds between
intervals of when mailing list
members are written out to the
mail server.
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Key Default Value Description

listingsPerPage 20 Maximum number of items
listed per page of any listing.

listingsPerFeed 20 Maximum number of items
that are included in rss or atom
feeds.

listingsPerMobilePage 20 Maximum number of items that

are listed per page on iPhone.

wikiCreators a dictionary of arrays Lists which users or groups are
wiki administrators. This can also
be set in Server Admin.

For more information on editing
this dictionary, see the following
topic.

Choosing Who Can Administer Wiki Server

You can choose who can administer Wiki Server in Server Admin or by editing
/etc/wikid/wikid.conf. For information about setting Wiki Server administrators in
Server Admin, see “Setting Up a Website for Wikis” on page 20.

In the wikid.conf file, there is a wikiCreators section that contains an array of wiki
administrators you can customize:

<key>wikiCreators</key>
<dict>
<key>hostname</key>
<array>
<dict>
wiki administrator keys and values
</dict>
<dict>
wiki administrator keys and values
</dict>
</array>

/<dict>
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Description

Short user name or group name.
This person or group becomes a
Wiki Server administrator.

Long user name or group name.
This person or group becomes a
Wiki Server administrator.

Set this to true if you entered a
group’s names. Set this to false if
you entered a user’s names.

Key Possible Values

shortName Lower case string with no
spaces

longName Any string

group <true/>, <false/>

moderate <true/>, <false/>

Set this to true to allow this user
or group to create wikis and
give wiki administrator access to
all wikis.

Set this to false to allow this
user or group to create wikis
but not give wiki administrator
access to all wikis.
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